Digital Performer 10.01 Read Me
Thank you for installing Digital Performer 10.01.
*****
Complete DP10 documentation
You can find complete DP10 documentation (PDF files) in Digital Performer's Help menu. Table of Contents
entries, index entries, and cross references are live links that will jump to their destinations. In some cases, you
may need to click directly on the page number (rather than the heading).
Changes and new features
For a comprehensive list of new features, please refer to New Features in Digital Performer 10, available in
Digital Performer's Help menu, which provides the page number in the manual for each new feature.

Enhancements introduced in version 10.01
Version 10.01 introduces the following improvements:
• Added a preference to completely disable tracks overview wiper snapping (Preferences > Editing > Tracks
Overview).
• Beat snapping honors the command key to toggle the snap state as you drag.
• Cancel run command by hitting the (shift-space) key again. This preserves the search text for next time.
• Applying a track layout preset hides tracks that did not exist at the time the preset was created.
• If saving an old Digital Performer document will upgrade it to a newer file format, the user will be reminded of
this and given a chance to use "Save As..." if backward compatibility is required.
• Added an option to allow DP to display audio meters post-pan (Play and Record -> Audio Options -> Audio
metering is post-pan).
• The maximum bus count is again 1024.
• Welcome window fixes: The news column now opens. Fixed a display glitch in the news show/hide button.
Fixed a problem with the drop shadows associated with each individual news item. When you're not on the
network, there is no 'Video Tutorials button.
• The consolidated window’s sidebar panel selection menu is now alphabetical within the logical subgroups.
• Reduced audio glitching when reordering tracks. Now a glitch will only occur if master track priorities need to be
resolved.
• Added string to value conversion to VST2 and VST3 plug-in formats.
• Removed the requirement that an AU plug-in be able to do string to value conversion in order to use value to
string conversion. The behavior when viewing and editing effect automation in DP is now, if value to string
conversion is available, it will be used. If string to value conversion is not available, events will not be editable by
typing in new values.
• Fixed a bug where a VST3's processor state could be restored to bogus values.
• Fixed an issue with all VST2/3 and AU plug-in formats, where examination could get blocked if the plug-in being
examined output too much diagnostic text (Fixes exam of GForce M-Tron and possibly others).
• Improved the way we send automation to VST3 plug-ins
• Fix redraw problems in the "Apply Plug-in" window (macOS 10.11 only).
• Fixed an issue where VCA masters would not control tracks with surround outputs.
• Fixed an issue where muted tracks controlled by VCAs could be distorted during playback.
• Fixing beat detection algorithm so it handles very small audio files (less than 0.1 seconds in length), this was
crashing DP.
• Improved Clips Window loading time when used with large numbers of tracks.
• Fixed a bug where the Clips window would appear to allow clip management for temporary take tracks.
• Fixed a crash when dragging an item over the Clips Window when no tracks are displayed.
• Fixed a crash that could occur when dragging the scroll bar in the clips window track selector if the clips window
was created outside of the consolidated window.
• Fixed a graphical glitch that could occur when scrolling horizontally in the clips window.
• Fixed a bug where revealing the track selector in the Clips Window would make right-most edge of the window
unreachable if the track selector was set to open inside of its edit window.
• Fixed a bug where the Clips Window track grid would be the wrong width after popping it into the Consolidated
Window while the track selector was showing.

• Fixed a bug where MIDI bindings bound to clips in the clips window wouldn't work if one or more v-racks
preceded the playchunk in the chunk list.
• Fixed a crash that could occur when closing a document containing more than one sequence with MIDI event
bindings for its clips
• Fixed a bug where soundbites within clips would not play for the correct duration if a tempo change occurred
while the clips were looping.
• Fixed a bug where a clip created by copy and paste would have its loop re-enabled if the source clip's loop was
disabled.
• Fixed a memory leak that could occur when undoing edits in the clip editor.
• Fixed a bug where copying and pasting clips in the clips window would create unnamed undo entries in addition
to "Paste Clip"
• Fixed a bug that made double-clicking unreliable in the Content Browser.
• Fix unpredictable behavior when using the Content Browser's back and forward buttons.
• Fixed an issue where the fade resolution system was not allowing asymmetrical cross-fades.
• If you delete the end off a soundbite with a fade, the fade is preserved. This behavior more closely matches DP
9.
• Fixed bugs that could result in fades not being created when the soundbite is off-screen.
• Fixed a crash bug that could occur when performing an Insert Measures where the split/insert point intersected
one or more sound bites.
• Fixed a few issues with Split Notes, including a crash that would occur when trying to send the selected notes to
a specific track.
• Fixed a crash that could occur when triggering a window set created in DP 9 or prior that contained a region op
window.
• Fixed an intermittent crash when opening the continuous data region op windows.
• Fixed a crash in SndBitePane.
• Fixed a Windows-only bug where the QuickScribe font would be used to render patch names in the patch list
menus.
• Fixed a crash when choosing a groove in the insert effect version of Groove Quantize.
• Fixed a potential crash when editing track options in the QuickScribe window.
• Fixed a graphical glitch with long Sequence Editor folder names.
• Fixed a cosmetic anomaly in the Markers window.
• Made the colored square in the track selector fit 10.2 and other surround sound labels.
• Added a conductor icon to the track selector in the 'Nine' theme.
• Made the insert automation box in the Sequence Editor line up.
• Fixed a graphics glitch in none more black theme.
• Made the track inspector button draw correctly meaning that the color stayed fill when the center column lost
focus.
• Fixed a bug where importing a clipping file would fail to reconnect track inputs to the appropriate input bundles if
the input bundle was a hardware input, rather than a bus or virtual instrument.
• Updated the Windows primary plug-in format alert text.
• Allow the track (context) name to be set into AU format plug-ins for all manufacturers.
• Notation editor zoom bug. DP would crash if the notation editor was open in the background and you zoomed
the MIDI editor.
• Fix layout issues in Final Cut Pro Import dialog.
• Fixed crash when exporting to AAF or OMF with "copy all audio files" selected

New features introduced in version 10.0
Version 10.0 introduces the following new features. For further information about these features, go to Digital
Performer's Help menu > New Features in Digital Performer 10.
Clips window — The Clips window is a dynamic, interactive environment for triggering audio and MIDI clips
during live performance. You can prepare any number of MIDI and audio clips and then individually trigger them
during playback. The Clip Editor lets you view, edit and create clips.
Audio stretch edit layer — Both the Sequence Editor and Waveform Editor have a new Stretch edit layer that
allows you to grab audio beats and stretch them earlier or later in time to modify their timing.
Beat Detection Engine 2.0 — DP’s Beat Detection Engine has been re-engineered to make beat and tempo

operations on rhythmic audio easier than ever.
Enhanced Waveform Editor — The Waveform Editor has been greatly enhanced and streamlined.
Content Browser — The new Content Browser gives you immediate access to assets that you can quickly drag
and drop into your Digital Performer project, such as audio files, loops, plug-ins, virtual instruments and clippings.
VCA tracks — Modeled after classic analog consoles, VCA tracks allow you to control the relative level of any
number of tracks from a single fader. With complete flexibility, you can control VCA tracks with other VCA tracks,
creating nested sub-groups. Mix automation is maintained throughout, even for sub-grouped faders.
VST3 support — VST3 plug-ins and virtual instruments are now supported in Digital Performer.
MOTU Instruments soundbank — DP10 includes a 5.5 GB library of multi-sample instruments, synths, loops
and phrases, including over 300 different instruments, 1100 instrument presets and 500 loops. Categories include
acoustic and electronic drum kits, pianos, guitars and basses, along with church organs, electric organs, strings,
brass, woodwinds, synths, ethnic instruments, choirs, voices, percussion, sound effects and more. For more
information, go to the Help menu in Digital Performer and choose Digital Performer Plug-ins Guide.
User interface scaling — You can now scale Digital Performer’s entire user interface, including all windows and
text, larger and smaller. This is especially useful on today’s high-resolution Retina displays.
Run command window — Type shift-spacebar (or choose Setup menu > Run Command…) to open the Run
Command window, which provides a command-line style interface for quick access to commands. Essentially, it’s
like Spotlight (in macOS) or Windows Search (in the Start menu) for commands. Several preferences are also
provided.
Enhanced Quantize — The Quantize command now offers the option to move MIDI controller data along with its
associated MIDI note when it is being quantized. This allows you to preserve the timing between the note and
any controller data affecting it. A separate option provides the same functionality for plug-in automation data for
soundbites when they are being quantized, or even beats within soundbites.
Enhanced Groove Quantize — The Groove Quantize command now offers the same option as above for
moving MIDI controller data and audio automation along with its associated MIDI notes and audio beats to help
preserve the timing between them.
Alternate Tool — The new Alternate Tool can be chosen in the Control Panel and invoked using the 'x' key (or
any customized keystroke), allowing you to switch quickly between the main tool and alternate tool without
repeated trips to the Tool palette.
Absolute vs. relative grid snapping — Now, by default, Snap to Grid (in the Snap Information window) snaps
data to the absolute time line grid. There is a new Snap Relative check box option that snaps data relative to its
original position with respect to the absolute grid.
Auto Snap to Grid — Snap to Grid now has two modes: Fixed and Auto. In Fixed mode, you can specify the grid
size, as usual. In Auto mode, DP chooses an appropriate grid size based on the zoom level of the edit window
you are working in.
Incremental transport cueing — In Digital Performer’s main transport controls, the cueing buttons (fast/slow
forward and rewind) can now be configured to cue in fixed increments in any time format. For example, you can
program the slow forward/rewind buttons to cue by one measure and the fast forward/rewind buttons to cue by
four measures. You can also cue by any number of beats, ticks, frames and seconds.
Region command presets — You can now create and save presets for Region menu commands such as
Quantize, Transpose, Change Duration and Split Notes.
Event list “quick” filter — The event list now displays a “quick filter” section at the top of the list to easily hide
types of data temporarily.

Effects inserts in the Sequence Editor — The Sequence Editor now displays effects inserts in an expandable
panel to the right of the track settings panel.
Enhanced track reordering — You can now select multiple tracks in the Track list (even a non-contiguous
selection of tracks) and then drag them together as a group up or down in the Track list to move them all to the
destination location in one step.
Overdub recording of MIDI CC data — When overdub recording MIDI continuous controller data, existing data
in the track is now replaced by new data according to the track’s automation mode setting (Touch, Latch, etc.)
Enhanced track data clippings — Clippings that consist of track data can be dragged and dropped into the
Track List, Track Overview and Sequence Editor. When doing so, you can now simultaneously create new tracks
and drop at a specific location on the time line, in one operation. In addition, any busing between multiple tracks
within the clipping is preserved.
Consolidated zoom menus — The zoom menus in the Sequence Editor, Drum Editor, MIDI Editor and
Waveform Editor have been consolidated into a single menu item in the main menu bar (View > Zoom).
Enhanced soundbite dragging — When dragging soundbites in the Sequence Editor to move them, Digital
Performer now displays their complete waveform while dragging to make it easier to align the waveform with
surrounding tracks. In addition, a new information tab appears while dragging to convey metrics such as the new
position, offset, start time and end time.
New MIDI note display preferences — There are several new preferences for the way MIDI notes can be
displayed in the Graphic Editor note grid. For example, you can display the MIDI note number and on-velocity bar
inside the note.
Canceling while dragging — You can now cancel in the middle of a dragging operation by pressing the escape
key.
Cell focus — When a cell in the Consolidated Window becomes the focused cell (by clicking its title bar), it now
displays a color-configurable border around the outside edges of the cell, to more clearly indicate that the cell has
the focus.
Bite Gain fader — When audio tracks are resized vertically in the Sequence Editor, and expanded far enough,
each soundbite displays its Bite Gain setting and fader in the bottom left corner.
Playback wiper snaps to grid — When you drag the playback wiper, it now respects grid snapping, if enabled.
To disable wiper snapping at any time, simply hold the command key (control key on Windows).
*****
We hope you enjoy using Digital Performer 10. We welcome your comments and suggestions.
Sincerely,
The Digital Performer Development Team
www.motu.com/techsupport
www.motu.com/suggestions
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